In a Ubuntu 20.04 LTS VM
sudo apt-key adv --fetch-keys http://repos.codelite.org/Codelite.asc

sudo apt-add-repository "deb http://repos.codelite.org/ubuntu/ $(lsb release
-sc) universe"

sudo apt-get update

sudo apt-get install codelite=15.0%*



Codelite

One of the better unknown IDEs with support for CMake is Codelite. Everybody has their favorite.
CodeBlocks is also installed in the DEV VM but we will cover configuring CodelLite now. The first run goes
like this.

Q codelitel

CodelLite

Welcome to the setup wizard
This wizard will help you setup CodeLite to fit your coding style. Click Next to continue

Mot this time!
If your Codelite is already configured the way you like it, click to skip the Wizard

MNexk = Cancel




Development Profile
Select the profile that best describes you

Default (Don't change the current settings) Both C/C++ and Web development
© C/C++development C/C++ development (Blockchain using EQSIO)
Web development (PHP, JS etc)

< Back Next = Cancel

Be sure to set for just C/C++.

Setup compilers
Let Codelite configure your installed compilers or help youinstall one

Scan
Click to scan your computer For installed compilers

< Back Mext = Cancel

Choose Scan.



Welcome!

Setup compilers
Let CodeLite configure your installed compilers or help you install one

Compiler Name Installation Path
GCC Jusr/bin
CLANG-10 /bin

Click Next.

Welcome!

Customise colours
Select the editor theme from the list below.
You can always change this from the menu: Settings -> Colours and fonts...

Theme: | System Default

class Demo {

private:
std::string m_str;
int m_integer;

public:

Next = Cancel

Choose a theme.



Whitespace & Indentation
Should CodeLite use TABS or SPACES for indentation?

Indentation
© Indent using SPACES

Indent using TABS
Whitespace Visibility:
Invisible

0 visible always
Visible after indentation

< Back Finish Cancel

Be certain we use spaces and have visible whitespace.
|
2 Settings Help

Preferences

Colours and Fonts...

Keyboard shortcuts...

5P

Settings->Preferences



Preferences

Guides Class doc template:

| * @class $(Name)
* @author $(User)

wdentation * @date 5(Date)
* @file s(CurrentFileName).$(CurrentFileExt)
Right Margin * @brief
Caret & Scrolling
save Optic
Code

Documentation  Function doc template:

:(_': (_' '|.(:‘| * @b riEf

Your standard class header template should be updated to include copyright and whatever else one
deems needs to be in each and every file. It pulls User and Date from the environment.

re Settings Help

Preferences
Colours and Fonts...
Keyboard shortcuts...
] ) o ~ |space
Environment Variables...  Shift+Ctrl+V gy workspace

Build Settings...

Settings->Colours and Fonts



Colours and Fonts
FBEEaLs o ey
General IDE Theme

Customize Use cuskom base colour:

Syntax Highlight

Global font: Liberation Mono Regular
Global theme: | Classic Eclipse

class Demo {

private:
std::string m_str;
int m_integer;

nithT4m -

Choose a font and theme you like. Do not import themes!

A Codelite restart is needed. Would you like to restart it now?

By now it will want to restart. Exit Codelite and restart.

]
v Plugins Perspective Settings Help

Manage Plugins...

— Diff Tool

EditorConfig

Git

Language Server

SFTP
SmartCompletions
Source Code Formatter
Wizards

Word Completion

b . . . . . . . .

wxCrafter

Plugins->Manage Plugins



AutoSave
CMakePlugin
CScope
CodelLite Vim
Copyright
CppChecker
DatabaseExplorer

MemCheck
Version : 0.5
Author : pavel.igx
Is Loaded? : No

Description:

Check All

Uncheck All

MemCheck plugin detects memory leaks. Uses Valgrind (memcheck tool) as

Diff Plugin backend.
Docker
EOswiki
EditorConfig
ExternalTools
Git
HelpPlugin
LLDBDebuggerPlugin
LanguageServerPlugin
v MemCheck
outline

Cancel oK

Enable these. The ones that aren’t shown in this image were left as defaults.

iger Plugins Perspective Settings Help

Manage Plugins...
— Diff Tool
EditorConfig

i New Workspace
cit Create a new worl
Language Server
SFTP ,
smartCompletions Ls

Source Code Formatter

Wizards Options... fo

Word Completion

v T T T v v v v v

wxCrafter

Plugins->Source Code Formatter->Options



General C+ PHP
Format editor on file save

C++Formatter: | AStyle

PHP formatter: | Builtin

Change to AStyle and check “Format editor on file save”

Source Code For

General C++ PHP

clang-format AStyle

PreDefined Styles ANSI
.
» Indentation Preprocessors
~ Formatting Break Blocks, Break Blocks All, Pad Parer
Break Blocks
Pad Parenthesis
Break Blocks All

Pad Parenthesis Outside

Break else-if

Pad Parenthesis Inside
Pad Operators

UnPad Parenthesis

One Line Keep Statement

Fill Empty Lines

One Line Keep Blocks

Brackets
Bracket Style options define the bracket style to use

AStyle Only: Custom user settings

#

# Do not let source lines go beyond this many characters
#

--max-code-length=130

--break-blocks

--convert-tabs

--break-one-line-headers

--pad-header

--break-blocks




Check the boxes to match above. Most important is to paste in the contents of our .astylerc. This plug-in
doesn’t have all of the switches we need.

Again, the content of this plugin and .astylerc will change based on the formal coding style based on The

Barr Group coding standard.

Apply and close.

Codelite

New Workspace
Create a new workspace

Select the workspace type:

Q|

C++

File System Workspace



New Workspace

Workspace Path: | /home/developer/Projects

Workspace Name: | codelitel

Generated File:
/home/developer/Projects/codelite/codelite.workspace

Create the workspace under a separate directory

Cancel oK

Put a codelite workspace under our Projects directory. Yes, CodelLite will want to restart right about
now.

A Codelite restart is needed. Would you like to restart it now?

Please do.



4 Workspace »  J

-
&4 v 5
workspace Mirroring »
CppCheck b
New » Mew Project
Build » New Workspace Folder

Add an Existing Project

Parse Workspace - Incremental
Close Workspace

Reload Workspace

Workspace Editor Preferences...

workspace Settings...

Right click on codelite and navigate to “New Project”

It’s worth pointing out the “workspace” concept at this point in time. You see “Workspace Editor
Preferences” and “Workspace Settings” on the submenu. That’s because a workspace isn’t a project, it’s
a working style. Each workspace can have its own coding style, tab settings, C++ document template. If
you are writing code for Spacely Sprockets in the morning you create a Spacely Sprockets workspace
that has their copyright information in the template, coding style, and other settings. In the afternoon
you might be coding for Really Cool Games Inc. so you have a different workspace for them.

One of the things not yet contained within these workspace specific things is your Git credentials. That
will be coming at some point.



New Project

Path:  /home/developer/Projects/codelite

Name: | fullscreen-1
Create the project in its own Folder

Category: | General

Type: = Custom Makefile
Compiler: = GCC
Debugger: | GNU gdb debugger

Build system: | CMake

Cancel 0K

We cannot use the GUI category here because NanoGUI does not yet have an entry in Type. Choose
“General”, “Custom Makefile”, GCC, “GNU gdb”, and CMake. That last one is really important.
Everything is moving towards CMake and that works the best in containers.

It used to be this IDE allowed you to create your CMakelists.txt file by hand. Now that they have all of
those “types” they want to control the content of that file, generating it as needed. Click on the little
wrench tool button with fullscreen-1 highlighted.

- EAF Vi TT o = B
rie cd vIEW oeadrcn VWOTKSE

L

Workspace View =

Workspace b Y

& 4@ F v £

« (= codelite

Fill in the General information as follows:



Debug

[General|

Compiler

Linker

Environment

Debugger

Resources
» Pre/Post Build Commands
» Customize

Code Completion

Global Settings

Project enabled
+ General
Project Type Executable
~ Build
» Makefile Generator CMake
Compiler GCc
Intermediate Directory
Output File Fullscreen-1
~ Execution
Pause when execution ends
Executable to Run / Debug S(workspacePath)/cmake-build-$(WorkspaceConfiguration)/output/$(P
Working Directory S(workspacePath)/cmake-build-$(wWorkspaceConfiguration)/output
Program Arguments
~ Debugging
Debugger GNU gdb debugger
Use separate debugger args
Debug Program Arguments

Checking the GUI application box tells Codelite to launch application without a console wrapper. Other
than that you should only have to fill in the “Output File”.

fullscreen-1 Project Settings

Debug
General L . .
Compiler :
¥ Options
Environment Use with global settings append
Debugger Linker Options -Wl,—~no-undefined
Resources Libraries Search Path
» Pre/Post Build Commands Libraries nanogui

» Customize
Code Completion
Global Settings



4 Workspace 4

&4 F v £

» (= codelite

Plugins... »
Pin Project

Export CMakeLists.kxt

Run CMake

BuilA

Right click on our project and choose “Run CMake”. You will see stuff like this scroll past in the build
window.

cmake /home/developer/Projects/codelite/fullscreen-1
—-— The C compiler identification is GNU 9.3.0

—-— The CXX compiler identification is GNU 9.3.0

-- Check for working C compiler: /usr/bin/cc

-- Check for working C compiler: /usr/bin/cc -- works
—-— Detecting C compiler ABI info

-- Detecting C compiler ABI info - done

-- Detecting C compile features

-- Detecting C compile features - done
-- Check for working CXX compiler: /usr/bin/c++
-- Check for working CXX compiler: /usr/bin/c++ -- works

-- Detecting CXX compiler ABI info

-- Detecting CXX compiler ABI info - done

—-- Detecting CXX compile features

-- Detecting CXX compile features - done

-—- Configuring done

-- Generating done

—-- Build files have been written to:
/home/developer/Projects/codelite/cmake-build-Debug/fullscreen-1
==== Done ====

Any subsequent time you “Run CMake” you will only see something like this.

cmake /home/developer/Projects/codelite/fullscreen-1

-- Configuring done

-—- Generating done

-- Build files have been written to:
/home/developer/Projects/codelite/cmake-build-Debug/fullscreen-1
==== Done ====



That’s because it caches all of the previous information.

$ 1s cmake-build-Debug/

$ 1s cmake-build-Debug/fullscreen-1/

CMakeCache.txt cmake_install.cmake Makefile

S

File Edit View Search Workspace Build Debugger Plugins Perspective
New > New Empty File Ctrl+N
Open b

MNew Project

Load a group of tabs

Previous iterations of Codelite used to create a main.cpp for “Hello World” but the current version does
not.

Right click and select “New Virtual Folder”

w [= codelite

Plugins...

Pin Project

Export CMakeLists.txt
Run CMake

Build

Rebuild

Clean

Stop Build

Project Only

Build Order...

Open Containing Folder
Open Shell

Make Active (double click)
Import Files From Directory...
Reconcile Project...

MNew Virtual Folder



New Virtual Folder

Name: @ src
Create the folder on the file system as well

/home/developer/Projects/codelite/fullscre

Cancel oK

&4 F a“v X

» (= codelite

| fullscreen-1
[src

Right click on the new virtual folder and view the menu.

&4~ v X

» (= codelite
v [ fullscreen-1

MNew Class...

Add a NewFile...

Add an Existing File...

New Virtual Folder

Remove Virtual Folder

Rename ...

Clear Background Colour

Set Custom Background Colour...

wxCrafter b

Previous versions of Codelite used to automatically create this folder and put a main.cpp for “Hello
World” in it. Our current one does not. Choose “Add a New File.”



File Type

C++Source File (.cpp)

C Source File (.c)
Header File (.h)

Any File
Name: main|
Location: | fhome/developer/Projects/codelite/fullscre Browse

oK Cancel

After clicking “OK” you will see main.cpp opened in the edit window. Paste in the following text.
#include <iostream>
#include "mainwindow.h"
using namespace nanogui;
int main(int /* argc */, char ** /* argv */)
{ nanogui::init () ;
/* cheat by using scoped variables */
{

MainWindow *mw = new MainWindow () ;

mw->set visible (true);
mw->perform layout ();

nanogui::mainloop (-1);

}

nanogui: :shutdown () ;
return O;

Save the file and you will see everything the editor believes is wrong.



src/main.cpp

1|9 #include <iostream=>

3 #include "mainwindow.h"

5|9 using namespace nanogui,

7 int main(int /* argc */, char ** /* argv */)
1 =0

9P nanogui::init();

1 /* cheat by using scoped variables */
2| |E {

2 MainWindow *mw = new MainWindow();
5 mw->set_visible(true);

6 mw->perform_layout();

A nanogui::mainloop(-1);

@1 }

1l nanogui: :shutdown();

2 return 0;

3 1

Right click on the src folder and choose “New Class”.

Class Name: = MainWindow *

Namespace:
Inherits: | |
File name: | mainwindow
Block Guard
Virtual Directory: | fullscreen-1:src

Path: = fhome/developer/Projects/codelite/fullscreen-1/src

File Advanced

Create .hpp instead of .h Use lowercase file names

Use #pragma once

Cancel oK




We use lowercase file names and #pragma once. After clicking “OK” navigate to the header file tab and
paste replace what is there with the following:

#pragma once
#include "nanogui.h"
using namespace nanogui;

class MainWindow

{

public:
MainWindow () ;
~MainWindow () ;

void set visible( bool yesNo);
void perform layout();

private:
void add navigation( Window *win);
void navigate to( int idx);

Screen *m_screen;
FormHelper *m gui;
Window *m_winl;
Window *m win2;
Window *m_win3;

bi

Ignore all of the red arrows you see on save. Now navigate to mainwindow.cpp tab and replace what is
there with the following:

#finclude "mainwindow.h"
using namespace nanogui;

MainWindow: :MainWindow ()
{
m_screen = new Screen (Vector2i (1024, 768), "Full Screen Test",
/* resizable */ false, /* fullscreen */ true);

m gui = new FormHelper ( m screen);
m winl m gui->add window( m_screen->size());
Label *1bll = new Label (m winl, "This is Window 1");

lbll->set color( Color (0, 0, 255, 1));
lbll->set position (Vector2i (100, 100));
m winl->add child(1lbll);

add navigation(m winl);

m win2 = m _gui->add window( m screen->size());
Label *1bl2 new Label (m win2, "This is Window 2");



lbl2->set color( Color (0, 188, 0, 1));
lbl2->set position(Vector2i (200, 200));
m winZ2->add child(1lbl2);

add navigation(m win2);

m win3 = m _gui->add window( m_screen->size());
Label *1bl3 new Label (m win3, "This is Window 3");

1bl3->set color( Color (0, 188, 0, 1));
1bl3->set position(Vector2i (300, 300));
m win3->add child(1bl3);

add navigation(m win3);

}

MainWindow: : ~MainWindow ()

{

/%
* Children are supposed to be deleted as long as they are parented.
* TODO:: run valgrind to be certain of this.

*/

}

void MainWindow::add navigation (Window *win)
{
ComboBox *cb = new ComboBox (win,
{"Example Window 1", "Example Window 2",
"Example Window 3"}
{"Window 1", "Window 2", "Window 3"});
cb->set callback( []() { navigate to( selected index());});

cb->set position( Vector2i (500,500));

win->add child(cb);
}

void MainWindow::navigate to(int idx)
{
switch ( idx)
{
case 0:
m _gui->set window( m winl);
break;
case 1:
m gui->set window( m win2);
break;
default:
m _gui->set window( m win3);
break;

void MainWindow::set visible (bool yesNo)

{

m_screen->set visible( yesNo);



}

void MainWindow: :perform layout ()

{

m_screen->perform layout();

}

Again, ignore the red arrows when you save. Right click on the project and choose “Run CMake” again.

v (= codelite 5] _
Ty re— | | class Maini:
* []src Plugins... »
“+ M PinProject 1
N !
* M Export CMakeLists.txt -
b 1
Run CMake e
Build

The IDE doesn’t know about new things until they’ve been added to CMakeLists.txt.



